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4
INTRODUCTION

introduction
The Glasgow School of Art enjoys an international reputation for the
quality of the studio-based education we provide, for the excellence
of our staff, for our many successful alumni and for our developing
areas of research excellence. This reputation has been built over
many years and over those years the School has remained successful
because it has been responsive to change in artistic practice and
change in its environment.
The thoughts of Charles Darwin in The Origin of Species are
relevant here:
“It is not the strongest of the species that survive, nor the most
intelligent, but the ones most responsive to change.”

>

This plan sets a course for 2008 and during that
period we continue to face change: significant and
continuous change in society, in the higher education
sector and in the professional sectors to which we
relate. As in previous centuries, The Glasgow School
of Art faces the challenge of finding ways not
only to survive but to thrive, in an environment
characterised by rapid transformation and to
do so without losing the qualities that built the
international reputation of which we are so proud.

The vision of The Glasgow School of Art
remains constant:
To provide world-class creative education and
research in architecture, design and fine art
which makes a significant cultural, social and
economic contribution.
The way in which we achieve the vision will change
as we respond to the demands of students and the
society in which we live. The plan is not fixed. It
provides a framework within which the professionalism
and creative potential of all our staff can shape and
contribute to the developments, ideas and partnerships
that ensure we rise to the challenges ahead.
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creative and cultural
There is every sign that the day of the creative individual and the
creative organisation has come.

THE CREATIVE INDUSTRIES
Creative industries are now recognised as a major
force in the UK economy. The Scottish Enterprise
Creative Industries Strategy acknowledges the key
role of education in delivering two of its main
objectives: the expansion and development of the
talent and skills base; and stimulating innovation
through research and commercialisation.
The Glasgow School of Art and the other art,
design and architecture colleges and faculties
across Scotland, have already played an important
role in building the creative and cultural industries
in Scotland. But we could do much more.
To help to develop the talent and skills base for
creative industries we need to increase our capacity
particularly at postgraduate level. Indeed, Scottish
Enterprise Glasgow in its recent Framework Document
for Creative and Cultural Industries1 talks specifically
about the need to increase postgraduate opportunities
in creative disciplines. Our ambition is to increase
the percentage of postgraduate students from its
current 8% to 15% in 2008 and to 20% by 2011.
The additional funds which SHEFC has provided for
research postgraduate provision is very welcome but
there is still a lack of taught postgraduate funded
places to support expansion. With, for example, only
92.5 postgraduate funded places in art and design
across Scotland (compare this with 1,150 postgraduate
funded places available to Computing Science with
equivalent undergraduate numbers to art and design)
the financial viability of courses becomes overly
reliant on fee income from overseas students who
are, in the main, less likely to move into the local
creative industries.
To support creative industries we also need to make
more seamless the transition from study to work.
Again Scottish Enterprise Glasgow talks about the
1
2
3
4

importance of ladders of support to creative
graduates. We are continuing to embed core and
transferable skills firmly and explicitly into our
project-based curriculum, piloting innovative
new approaches which appeal to creative minds,
supported in this by the Scottish Institute for
Enterprise2. We are also developing graduate
bridging projects in partnership with NESTA and
the Lighthouse3 and exploring new models whereby
the technical resources we have and our highly
skilled and knowledgeable academic and technical
staff could continue to support graduates as they
establish themselves as new creative businesses
and cultural ventures.
The international competitiveness of Scottish
creative industries will be driven not simply by
the size of the sector but also by its capacity
for innovation and invention. The research and
knowledge transfer activity that is being developed
at The Glasgow School of Art is an important means
of driving innovation and invention, but the very
significant and welcome increase in Government
funds for knowledge transfer for higher education
generally is not finding its way to the creative
disciplines. The metrics being used to allocate funds
are quite simply inadequate in responding to creative
disciplines and the needs of creative industries and
the cultural sector.
The Minister for Enterprise and Lifelong Learning,
in his guidance letter4 to the Scottish Higher
Education Funding Council, asks SHEFC to look at
how the contribution of the sector to the creative
industries can be enhanced. It is to be hoped that
the needs being identified in the Council’s recently
established Creative Industries Working Group and
reflected above can be addressed.
Of course, the creative industries themselves and the
nature of practice in fine art, design and architecture

Scottish Enterprise Glasgow Framework Document for the Creative and Cultural Industries 2004
Insight Out Learning
National Endowment for Science, Technology and the Arts and the Lighthouse Centre for Architecture, Design and the City
Scottish Executive, letter of guidance to SHEFC from the Minister for Enterprise and Lifelong Learning January 21 2005
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change at a relentless pace. Our courses, the research
and the knowledge transfer activity we engage in,
must remain relevant both to the creative and
cultural industries and, increasingly, to wider society.
Regularly reviewing course content and the overall
relevance of the course portfolio is embedded in
our planning. In particular, our education and
research must reflect the increasing inter-disciplinarity
of creative practice. A good start has been made
in encouraging synergies across our Schools and
Departments; in developing inter-disciplinary courses
at undergraduate and postgraduate levels; and in our
emerging areas of inter-disciplinary research.

CREATIVITY AND THE KNOWLEDGE ECONOMY
The creativity, which The Glasgow School of Art
nurtures, is increasingly valued in the wider society.
In Smart Successful Scotland5, the Scottish Executive
acknowledges that Scotland’s “economic success
depends on the people of Scotland, their creativity
and enterprise.”
In one of the most influential books on the economy
to be published recently, The Rise of the Creative
Class, Professor Richard Florida of Carnegie Mellon
University6 argues that “creativity is now the decisive
source of competitive advantage. In virtually every
industry, from automobiles to fashion, food products
and information technology itself, the winners in the
long run are those who can create and keep creating…
creativity has come to be the most highly prized
commodity in our economy.”
Florida’s new theoretical construct for economic
development is based on three pillars. Firstly, those
who are creative in their work now represent a
significant class in society (approximately 30%
of the workforce in the USA). Secondly, the health
of the economy depends on its ability to nurture,
attract and retain creative people. Thirdly, creative
people are drawn to cities, which comprise large
numbers of creative people, which are socially diverse
and tolerant and which have a rich cultural life.
In this framework, The Glasgow School of Art’s role
in the economy is twofold.

5
6

Firstly, we develop graduates with the qualities
needed by today’s wider economy – creative lateral
thinkers and enterprising, self-motivated, risk takers.
We need to strengthen our efforts to ensure that the
value of creative education is clearly understood by
governments, by employers, by educationalists, by
funders and, last but not least, by our graduates.
Secondly, we help to build and sustain in Glasgow
a cultural environment which acts as a magnet to
creative people. The city of Glasgow is fast building
an international reputation as a dynamic centre for
visual culture and the GSA continues to play a
defining role in that reputation. We need to promote
that role within the City and, in partnership, develop it.
The GSA attracts students from all over the world,
many of whom wish to stay. A joint programme
with the Central Academy of Fine Arts in Beijing, for
example, will bring in 40 to 45 highly able Chinese
students each year from 2006 to complete their
degree level studies. The Master of Fine Art course
has 50% overseas students and growth in other
postgraduate areas will follow similar patterns. The
Scottish Executive Fresh Talent initiative will make
it easier for overseas students to remain and, with
support from the City Council and local development
agencies, a robust creative infrastructure should
sustain them in the City.
Joseph Beuys’ prophetic statement “creativity is
national income” has never been truer than it is today!

THE CULTURAL ROLE
The importance of our cultural life was affirmed
when the First Minister of Scotland, in his St
Andrew’s Day address in late 2003, talked about the
centrality of cultural activity to all aspects of our
lives. He wanted Scotland to have “the courage and
faith to back human imagination, our innate creativity,
as the most potent force for individual change and
social vision”. And he proposed that every department
within the Scottish Executive examines the role
which arts and cultural development can play. In
particular he sees our cultural reputation playing
a significant part in creating an image of Scotland
abroad which is modern, diverse and dynamic.

A Smart Successful Scotland: Ambitions for the Enterprise Network. Scottish Executive 2004
The Rise of the Creative Class – and how it is transforming work, leisure, community and everyday life. Richard Florida. 2002.
Basic Books INSN 0–465–02476–9
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In his guidance to SHEFC in January 2005, the
Minister for Enterprise and Lifelong Learning
emphasises the importance of culture and creativity,
stressing that the HE sector has an important role in
developing cultural activity, awareness and expertise
through creating wider access to cultural activity and
helping to develop creative talent across different
sectors of the economy.

In a world increasingly caught up in instrumental
justifications it is important to assert the importance
of art and artists for their own sake. We continue
to take pride in nurturing artists who enrich our
lives, who help us see things from new perspectives,
who engage our emotions and our senses. This is
justification enough.

The Knowledge Transfer Task Force of the Scottish
Higher Education Funding Council has published
a discussion document7 which acknowledges the
important role that higher education institutions
have in promoting and supporting cultural activities
and engaging culturally with their communities, both
geographic and interest. The discussion document
proposes a dedicated stream of funding to further
develop that engagement which is welcome.
The Glasgow School of Art’s cultural engagement
of course takes many forms. There is the work of
our staff, students and graduates; our exhibition
programmes; our continuing education classes and
summer schools; and the access we give the public
to our heritage – the magnificent Charles Rennie
Mackintosh building which remains at the heart of
our campus and the School’s rich collections and
archives. Internationally too, The Glasgow School
of Art enhances Scotland’s profile and reputation.
Our staff win international accolades. Our students
exhibit internationally – in 2005–6 for example, the
Master of Fine Art Degree Show exhibition will visit
Beijing and Tokyo. Our graduates represent Scotland
in disproportionate numbers. 60% of the designers
representing Scotland at the 2004 International
Design Fair were GSA graduates. 100% of the artists
representing Scotland at the 2005 Venice Biennale
are GSA graduates.
Whilst we welcome the fact that this aspect of the
GSA’s work – the cultural contribution we make
locally, nationally and internationally – is now
formally recognised, it is important to recognise that
any funding for cultural engagement should be
additional to, and not a substitute for, more inclusive
metrics which capture the full range of knowledge
transfer in the creative disciplines.

7

Cultural Engagement: an imperative for Higher Education. Scottish Higher Education Funding Council March 2005
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THE EDUCATION ENVIRONMENT
There are challenges and opportunities also in the higher education environment.
The Scottish Executive’s Framework for Higher Education in Scotland Phases 1 – 38; its
Lifelong Learning Strategy9; and the Treasury’s Lambert Review of Business-University
Collaboration10 provide a clear statement of Government priorities for the future. The
changing nature of society, the changing profile and needs of students, too, are major
factors in planning our education and research of the future.
LEARNING AND TEACHING
The key challenge for the education sector is to
recognise a significant shift in society towards
lifelong learning because, in Alvin Toffler’s words,
“The illiterate of the 21st Century will not be those
who cannot read and write but those who cannot
learn, unlearn and re-learn”.
The seamless progression of a learner through
different levels of education is the rationale behind
the introduction of the Scottish Credit and
Qualifications Framework (SCQF) and the emphasis
on improved articulation for students between
further and higher education. The demographic
changes facing the UK, with reductions in the
number of 17 – 24 year olds, means that the
traditional market for higher education is declining
and this, too, demands a different response from
education providers. The overall demand, therefore,
is for a greater focus on the needs of a wider range
of students and on flexible modes of delivery and
support services which respond to those differing needs.
The GSA is responding to these challenges by
embracing the SCQF, by exploring different modes
of delivery and by working with partner Further
Education Colleges to explore articulation routes.
Students are increasingly concerned about how
their education equips them for the transition into
the world of work. The GSA is responding to that
concern by ensuring that core and transferable skills
are deeply embedded in the curriculum; by increasing
its provision of Masters level courses; by promoting
enterprise learning through the Scottish Institute for
Enterprise and by exploring ways in which we can
build bridges between study and work at all levels.
Scotland has a new quality assurance regime which
rightly focuses on the enhancement of quality
8
9
10

as well as its assurance. The Enhancement Led
Institutional Review forms a major part of that
new regime and the GSA’s Institutional Review
in early 2005 resulted in the Quality Assurance
Agency reporting Broad Confidence, the highest
of three bands, in the management of the quality
of provision and the academic standards of awards.
The review provided an invaluable opportunity
to shine a light on the way in which the School
manages and continually enhances the quality
of its learning and teaching and assures standards.
The Glasgow School of Art has an international
reputation for the excellence of its education.
Continuous reflection and quality enhancement
is the way to ensure we keep it. Another way is
to nurture deep engagement between staff and
students across international networks of likeminded institutions of equal educational standing
through exchange programmes, international
workshops and joint programmes.

WIDENING ACCESS
Widening access is a priority for The Glasgow
School of Art. Our widening access programme
tackles recruitment, admissions and retention.
In all three, progress is being made. Applications
from people from disadvantaged backgrounds
increase very markedly year on year; our
admissions policy and procedures are under
scrutiny and our relatively new learning support
service, integrated into mainstream learning and
teaching, helps to ensure that the retention of
wider access students is maintained at or near
the level of other students.
We see no contradiction between widening access
and continuing to provide the world-class education
in art, design and architecture to which we aspire.
Quite the opposite.

Scottish Executive: A Framework for Higher Education in Scotland Phases 1 – 3 2003-4
Scottish Executive: Life through Learning; Learning through Life: The Lifelong Learning Strategy for Scotland, February 2003
H.M.Treasury: Lambert Review of Business-University Collaboration December 2003
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RESEARCH
The Government’s agenda for higher education
research and knowledge transfer is also becoming
clearer.
Higher education research in Scotland is already
successful and internationally competitive. The Scottish
Executive wants to enhance this success by increased
targeting of research funding towards areas of
international excellence. The Scottish Higher Education
Funding Council believes that this can be achieved by
collaboration and the pooling of resources rather than
by competition between institutions. In response, the
GSA is a core partner in the development of a Creative
Disciplines Research Network.
The Scottish Executive has also acknowledged that
much interesting research is developing in the areas
between traditional discipline boundaries. This is
where some of The Glasgow School of Art’s research
interests also lie with advanced research centres like
the Digital Design Studio increasingly working in
areas such as medicine and naval architecture; and
with emerging research themes such as Living Cities
and Inclusive Design taking an explicitly interdisciplinary approach. We would, however, also
defend vigorously research which achieves excellence
within traditional disciplines and research centres in
drawing, in environmental architecture, and in digital
textiles are also being pursued.
But, of course, the Government agenda is not the
only reason why The Glasgow School of Art has high
ambition for its research. World-class research, which
engages with the professional sectors, industry and
the community, makes a significant contribution to
society and that is part of our vision. It also connects
us to global networks, enriches teaching, ensures
that we remain internationally competitive and able
to attract excellent staff and students.
The increased quality research funding which
followed our improved performance in the 2001
Research Assessment Exercise has provided an
excellent foundation to support our aspirations. With
a network of Research Developers, PhD Co-ordinators,
Senior Researchers, Researchers and Visiting
Professors, our ongoing strategy is to develop

a number of research centres of international
excellence like the DDS; to develop strength in
research themes like Living Cities and Inclusive
Design; to increase the proportion of research active
staff to 80% by 2008; to increase the number of PhD
students to 55 by 2008, and enhance the international
quality of research outputs throughout.

KNOWLEDGE TRANSFER
So important has knowledge transfer become
for Government, that the funding provided to
support it is being seen as the Third Stream after
Teaching and Research. Post the Lambert Review
of Business-University Collaboration it is set to
increase significantly.
The Glasgow School of Art engages enthusiastically
in activities which make a contribution to the
economy. Two phases of Scottish Enterprise Proof
of Concept grant, for example, are supporting
the development of 3Motion, a human-computer
interaction device; the work of the Centre for
Advanced Textiles brings digital textiles design and
print expertise to local and international businesses;
consultancy services are provided by the Mackintosh
Environmental Architectural Research Unit into energy
efficient housing; and student designs are being
licensed for product. We are also exploring how we
can increase provision of continuing professional
development to benefit creative industries.
We also, as has been said, make a major contribution
to the cultural life of the nation – the exhibitions,
publications, student projects, continuing education
classes, conferences, lectures and seminars and, last
but not least, our heritage both as the guardian of
Charles Rennie Mackintosh’s masterwork and
collections and as one of the oldest art schools in
the United Kingdom. This too is knowledge transfer
in its broadest sense and that this is now acknowledged
by SHEFC is a very positive development.
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PEOPLE AND PLACE
People and place are the two most important factors in sustaining world-class
education and research. The Glasgow School of Art must continue to be characterised
by excellent staff and must build a strong resource base if it is to fulfil its ambitions.

PEOPLE
The Bett Report11 still remains a potent force in
shaping the human resource landscape in higher
education. The recent agreement between the
Universities and Colleges Employers Association
(UCEA) and the trades unions on a single pay spine
supported by robust job evaluation has far reaching
consequences not least in the ability of institutions
like the GSA to meet the inevitable costs without
additional funding. For the GSA, this process needs
also to be set within a broader framework of a
coherent new pay and rewards strategy.
Alongside Bett lies the Government’s commitment
to facilitating professional development and
improving the professional standing of staff in higher
education through the establishment of the Higher
Education Academy and the Leadership Foundation.
This priority the GSA shares with the Government.
The GSA can only provide world-class education and
research if we can continue to recruit, develop and
retain high quality staff. We have made substantial
progress in modernising the human resources service
at the GSA and in establishing a comprehensive
human resources strategy: our efforts must be
sustained into the future. Career review and
personal development planning has been introduced
and will continue to be rolled out across the
institution. Activity planning will help determine
the balance between teaching, research and other
responsibilities for academics to meet more
effectively the needs of the individual and the
needs of the School. Further investment in staff
development and leadership training is essential
to improve management effectiveness in academic
and support departments and, at the same time, a
coherent programme of academic staff development
will be taken forward to further enhance quality and
innovation in learning and teaching.

The effectiveness of the School’s Board of Governors,
already reviewed internally on a regular basis, can
now be measured against a new UK wide Code of
Governance. It has not been found wanting.

PLACE
Education is now a global sector. Our competitors
are no longer just Edinburgh, Aberdeen or Dundee
but institutions throughout the world. The quality
of the teaching, the international standing of the
GSA staff, the sense of the GSA community and the
reputation of Glasgow as a dynamic, creative city
remain the most important factors in maintaining
our competitive edge. The physical environment
of the GSA is, however, in danger of seriously
undermining it.
The Garnethill campus is very poor. It fails to
provide a learning, teaching or research environment
which is in any way adequate to meet the ambitions
of the School in terms of its quality, its flexibility,
its cost effectiveness, the image it projects to future
students, staff and partners or its ability to
accommodate planned growth in international
students, postgraduate provision and research
activity. Having concluded, on the basis of studies
into the condition of the estate, its fitness for
purpose and the utilisation of space, that only a
major redevelopment could sensibly address the
inadequacies, an options appraisal was commissioned
with support from SHEFC.
The aim now is to build the case for significant
investment from SHEFC, the Scottish Executive
and other partners in the option identified – the
disposal of outlying buildings and the focus for
redevelopment on two sites around the Mackintosh
Building and on Renfrew Street. The creation of a
high quality, fit for purpose campus designed for
the 21st Century is a major factor in ensuring the

11 The Independent Review of Higher Education Pay and Conditions: Report of the Committee chaired by Sir Michael Bett June 1999
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School remains nationally and internationally
competitive. A drive to also ensure a level of IT
infrastructure, which supports the learning, teaching
and research ambitions of the School, also features
in our plans. Both will require very significant
investment from public and private sectors.

The redevelopment of the estate also has major
financial implications. The bulk of the capital
investment must, by necessity, be secured from
partners in the public and private sectors but the
School must be able to maintain its new estate
adequately and fund any limited borrowing required.

At the heart of the estates redevelopment will
remain the Mackintosh Building. A Stage 1
agreement for funding of £4.466m has been
secured from the Heritage Lottery Fund for the
Mackintosh Conservation and Access Project. If
confirmed at Stage 2, the grant will enable us to
conserve and restore the building, collections and
institutional archives; bring studios and other
apartments back to their original use; create new
exhibition areas and an interpretation centre
and increase the number of visitors without
compromising the building’s primary purpose
as a working art school.

To achieve these goals the School’s strategy is to
generate significant additional income over the
planning period and beyond and to minimise capital
expenditure in the short to medium term in order
to increase liquidity further. The School will secure
additional income by increasing overseas student
numbers, increasing research income and by the
commercialisation of products and intellectual
property, particularly those in development at the
Digital Design Studio. It will also generate funds
by the sale of existing buildings freed up as the
campus is concentrated.

Located in House for an Art Lover in Bellahouston
Park, the growth plans of the ground breaking
Digital Design Studio are also constrained by its
current accommodation. The DDS ambition is to
relocate to the Digital Media Campus on Pacific
Quay. With Scottish Enterprise support a growth
plan and feasibility study have been completed
and the potential for DDS to become a key
anchor tenant of this important creative industries
development is now actively under consideration.

FINANCE
Both people and place can be sustained only
through an effective financial strategy.
The context is challenging. Increases in SHEFC
funding have remained below the real costs of
implementing national pay awards. The new
National Pay Framework will be in place by August
2006 and, given that pay at the GSA represents well
over 60% of expenditure, will have significant costs
– in both designing and implementing the new pay
structures. In England, higher education institutions
are benefiting not only from additional support for
modernising pay structures but also, from 2006
onwards, from the ability to charge variable fees
that will bring in a stream of additional teaching
income which is not assured in Scotland.

These are ambitious plans which require
determination and the collaboration of a wide
range of partners from the public, private and
personal sectors of society. The staff and Board
of the GSA are convinced that the value of the
GSA and its contribution to society, locally,
nationally and internationally, merit such faith.
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VISION AND OBJECTIVES
The vision of The Glasgow School of Art is:
To provide world-class creative education and research in
architecture, design and fine art which make a significant
cultural, social and economic contribution.
We will achieve that vision by fulfilling 5 major objectives:
OBJECTIVE 1

To provide creative education of the highest quality

OBJECTIVE 2

To ensure our student community reflects the
diversity of society

OBJECTIVE 3

To develop research of international standing

OBJECTIVE 4

To use our research, expertise and resources to
bring benefit to Glasgow, Scotland and beyond

OBJECTIVE 5

To be an organisation characterised by excellent
staff and a strong resource base

The following pages detail the strategies which have been agreed for the four year
period from 2004 – 2008 and the main plans identified for 2005 – 2006.
The full strategy, which includes a report on progress in 2004 – 2005, student number
projections and a summary of the income and expenditure budget, is available on the
GSA website on www.gsa.ac.uk/publications
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OBJECTIVE 1
To provide creative education of the highest quality
Our objective is to provide creative education of the highest quality which promotes inter-disciplinarity
and builds synergies across the School; which remains relevant to national and international contexts;
which uses flexible modes of delivery in response to the changing needs of students and which benefits
from links to research.
Over the period of the Plan 2004 – 2008 we will do this by:
Encouraging research, development and innovation in learning and teaching
In 2005 – 2006 our priority will be to
> Promote innovation and share good practice in learning and teaching
> Promote membership of the Higher Education Academy (25% increase in 2005 – 2006) and encourage
a high take up of accredited academic practice training (12 staff complete training)
> Establish a Research Centre for Creative Education
Ensuring that quality enhancement is firmly embedded in all aspects of learning and teaching
In 2005 – 2006 our priority will be to
> Implement recommendations of the Report of the Quality Assurance Agency Enhancement Led
Institutional Review
> Complete outstanding work on Common Academic Frameworks, accreditation of prior learning and prior
experiential learning and progress work on personal development plans
> Monitor and review impact of the changes in student feedback mechanisms and in student representation
on academic committee structures introduced in 2004 – 2005
> Plan for a programme of thematic reviews to include Historical and Critical Studies and Student Support
Providing students with core and transferable skills which will enable them to thrive in the world
of work
In 2005 – 2006 our priority will be to
> Develop the GSA employability strategy, engaging actively with the QAA Enhancement Theme
> Promote enterprise learning through the work of the Scottish Institute for Enterprise and the
SIE student interns
> Roll out the Insight Out Learning curriculum guidelines across the GSA and the Scottish HE sector
Encouraging inter-disciplinary approaches to learning and teaching
In 2005 – 2006 our priority will be to
> Complete the arts and science pedagogy programme at the Digital Design Studio and develop
an undergraduate degree programme
Ensuring our portfolio of courses and modes of delivery remain relevant to a rapidly changing
society
In 2005 – 2006 our priority will be to
> Continue to monitor relevance through periodic review of programmes
Developing and promoting postgraduate opportunities
In 2005 – 2006 our priority will be to
> Develop and implement the postgraduate growth strategy to increase overall taught and research
postgraduate numbers to 15% by 2008 and 20% by 2011
> Secure scholarships to support needy postgraduate students
> Develop a targeted marketing strategy for taught and research postgraduate programmes
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Sustaining and developing international partnerships
In 2005 – 2006 our priority will be to
> Oversee the delivery of the inaugural First Year Programme in Fine Art, Design and Architecture at the
Central Academy of Fine Arts in Beijing
> Prepare for CAFA students articulating into GSA Year 2 degree courses from October 2006
> Scope an international strategy to provide a framework for high quality international partnerships
> Engage actively with the work of the European League of Institutes of the Arts
Providing high quality information, communication and IT infrastructure which meets the academic
needs of the GSA
In 2005 – 2006 our priority will be to
> Continue to develop a virtual learning environment
> Create a wireless network environment across the campus
> Develop an academically led IT strategy which meets the needs of future directions in learning, teaching
and research
OBJECTIVE 2
To ensure our student community reflects the diversity of society
The overall student profile in higher education in the UK does not match that of society at large. The same
is true of the GSA’s student profile where students from less advantaged backgrounds are less represented
proportionately in the student population. The difference lies not in creative ability or intelligence but often
in the lack of opportunities that have been available and in the limited confidence and aspiration that
result. This objective is about tackling inequalities where it lies within our power to do so.
Over the period of the Plan 2004 – 2008 we will do this by:
Increasing applications from those groups currently under-represented in the student community
by 10% per year
In 2005 – 2006 our priority will be to
> Complete the FE-HE development project and establish articulation agreements with selected Further
Education Colleges in Glasgow
> Increase applications from students in state schools by expanding the Portfolio Preparation Programme
> Undertake research into the factors influencing low application rates from ethnic minority communities
> Secure scholarships and bursaries for students from disadvantaged backgrounds
Ensuring fair and transparent recruitment and admissions practices
In 2005 – 2006 our priority will be to
> Review the GSA’s admissions policies and procedures
Enhancing the retention of students from under-represented groups
In 2005 – 2006 our priority will be to
> Develop bridging summer schools for GOALS students and FE students articulating into Year 2
> Research into issues which undermine retention and explore the potential for a personal tutor system
for GOALS students
Demonstrate commitment to diversity through the form and content of the curriculum
In 2005 – 2006 our priority will be to
> Prepare for a curriculum audit on diversity issues in 2006 – 2007
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OBJECTIVE 3
To develop research of international standing
Our objective is to develop research of international standing which supports learning; involves a high
proportion of GSA staff; and engages with industry, community and the professional creative sectors. The
aim is to mature the research culture at the GSA and, in the short term, enhance our position in the 2008
Research Assessment Exercise.
Over the period of the plan 2004 – 2008 we will do this by:
Continuing to develop existing and emerging research centres to be centres of international
research excellence
In 2005 – 2006 our priority will be to
> Secure investment in the Digital Design Studio growth plan
> Complete negotiations with Scottish Enterprise and other development partners on the relocation of the
DDS to the Digital Media Campus at Pacific Quay
> Implement clear strategies for existing Research Centres (Mackintosh Environmental Architecture
Research Centre, Centre for Research into Art in Social Contexts, Centre for Advanced Textiles,
International Drawing Research Institute, Visual Cities, Centre for Collections and Archives) to include
raising research funds, providing a hub for PhD study, critical mass for PhD supervision, a framework for
individual researchers and the potential for developing of taught Masters
> Complete the feasibility study for Living Cities and develop a major grant application
> Develop clear strategies for emergent research centres (The Cell and Centre for Creative Education)
Developing research clusters, particularly those which promote inter-disciplinarity
In 2005 – 2006 our priority will be to
> Refine plans for research clusters across the GSA including pedagogy, history and theory, drawing and
inclusive design and their relationship to Research Centres
Pursuing research which is collaborative and engages in national and international networks
In 2005 – 2006 our priority will be to
> Be a partner in the development of the pan-Scotland research network in creative disciplines
if the current proposal for a Strategic Research Development Grant is agreed by SHEFC
> Further develop international research partnerships including the International Drawing Research
Institute with Central Academy of Fine Arts in Beijing and College of Fine Arts, Sydney
> Develop inter-disciplinary research partnerships with other institutions e.g. Design in the 21st Century
with the medical faculty of the University of Glasgow and medical training with the Royal College of Surgeons
Nurturing and supporting emergent researchers with a view to achieving 80% of GSA staff
research active by 2008
In 2005 – 2006 our priority will be to
> Work with staff to develop and support individual research plans and provide mentoring to less
experienced researchers including research workshops and seminars
Increasing externally generated research income at least two-fold by 2008
In 2005 – 2006 our priority will be to
> Increase the number and success rate of applications to research councils, industry partners, trusts and
foundations, reducing research centre and individual dependency on main quality research grant
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Disseminating research outputs more effectively
In 2005 – 2006 our priority will be to
> Increase research publications including an annual research report and disseminate outputs to a national
and international audience
Strengthen the infrastructure for research and research postgraduate study
In 2005 – 2006 our priority will be to
> Establish regular staff and student research and postgraduate forums
> Make available accredited PhD supervision training
> Undertake a trial run Research Assessment Exercise in 2005
OBJECTIVE 4
To use our research, expertise and resources to bring cultural, social and economic benefit to
Glasgow, Scotland and beyond
Our objective is to ensure that we remain externally referenced and use our research, expertise, ideas and
resources to bring benefit – economic, social and cultural – to the City, nationally and internationally.
Over the period of the Plan 2004 – 2008 we will do this by:
Ensuring GSA knowledge transfer policies and activities remain relevant and appropriate to the
context in which we work
In 2005 – 2006 our priority will be to
> Ensure that knowledge transfer outputs are explicit in every research plan
> Review the Knowledge Transfer Strategy in the light of the work of SHEFC’s knowledge transfer task
force and cultural engagement sub group
> Contribute to the national debate about appropriate knowledge transfer metrics for the creative disciplines
Identifying opportunities to commercialise the GSA’s research and intellectual property
In 2005 – 2006 our priority will be to
> Finalise commercialisation arrangements for DDS 3Motion (formerly Smartfinger) development
> Develop Centre for Advanced Textiles and Classictextiles.com linked to Mackintosh and other
GSA textile archives
Developing continuing professional development and consultancy services
In 2005 – 2006 our priority will be to
> Explore the potential for all new Masters courses to include self standing modules available as CPD
Building bridges into the world of work to encourage graduates to remain in Glasgow and Scotland
and support creative and cultural industries
In 2005 – 2006 our priority will be to
> Partner the National Endowment for Science, Technology and the Arts and the Lighthouse to develop
Year 2 of Insight Out, a new approach to creative business development for recent graduates
> Explore with other Scottish HEIs the potential to collaborate on the design and operation of bridging
schemes for graduates into creative industries
> Implement findings of the feasibility study into the GSA acting as a resource hub for creative industries
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Preserving and promoting the Mackintosh heritage and the GSA’s Collections and Archives
In 2005 – 2006 our priority will be to
> Move to Stage 2 of Heritage Lottery Fund submission for the Mackintosh Conservation and Access Project
> Establish fundraising strategy and structures to raise the balance of funding needed to complete the
Mackintosh Conservation and Access Project
> Promote the importance of Mackintosh by working closely with the Mackintosh Society and other
interested parties
Strengthening the GSA Continuing Education Programme
In 2005 – 2006 our priority will be to
> Continue to develop high quality continuing education programmes and summer schools
Playing a role in the economic and cultural success of Glasgow
In 2005 – 2006 our priority will be to
> Contribute to the development and implementation of economic, social and cultural strategies for the
future of Glasgow
> Organise high quality exhibitions and conferences
Influencing policy makers on issues which affect our sector and where we can make a strategic
contribution
In 2005 – 2006 our priority will be to
> Raise the profile of creative education and its impact on creative industries and the wider economy
through the work of the Centre for Creative Education
> Continue to organise visits to the GSA by Ministers, MSPs, senior civil servants and other influential
people nationally and internationally
> Encourage the engagement of GSA staff and students in external bodies and policy development and
identify a means of recording and recognising such
OBJECTIVE 5
To be an organisation characterised by excellent staff and a strong resource base
The fulfilment of our ambitions depends on having an outstanding staff, a high quality campus, excellent
information technology resources and financial stability.
Over the period of the Plan 2004 – 2008 we will do this by:
Recruiting, developing, supporting and retaining excellent academic and support staff
In 2005 – 2006 our priority will be to
> Devise and implement a response to the National Pay Framework underpinned by a pay and rewards strategy
> Ensure career review, activity planning and personal development planning is embedded across the institution
> Review employment patterns and outstanding contractual issues
> Develop a programme of accredited academic practice training to start in 2007 – 2008 and, in the
interim, source appropriate training from an external provider for all new staff as a requirement of
induction and for existing staff
> Initiate a programme of staff and leadership development for senior staff
> Improve opportunities for formal and informal debate and dialogue across the Schools through research
forums, learning and teaching seminars, a staff led forum and a Headroom Day
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Redeveloping the Glasgow School of Art campus on Garnethill to provide a high quality learning,
teaching and research environment and to accommodate growth
In 2005 – 2006 our priority will be to
> Refine the master plan for the redevelopment of the Garnethill campus and develop the full business
case for presentation to SHEFC and other funding partners
> Secure investment from Scottish Executive, SHEFC and other funding partners to implement the
redevelopment plan for the Garnethill Campus
> Agree the redevelopment process and refine the design brief in preparation for an international
architecture competition
> Put in place the staffing and committee structures to support the Capital Fundraising Campaign
> Establish an Estates Development office
In the short term, improving the existing Garnethill campus to maintain an acceptable
environment for learning, teaching and research and accommodate limited growth
In 2005 – 2006 our priority will be to
> Improve utilisation to accommodate growth in student numbers
> Target available resources to maintain quality in the learning and teaching environment
Providing a sophisticated IT infrastructure that meets the School’s operational needs
In 2005 – 2006 our priority will be to
> Complete Phase 1 of implementation of a new student record system to be operational by September 2005
> Establish an information management system to accommodate significant growth in electronic data
Improving organisational structures and processes to meet changing needs
In 2005 – 2006 our priority will be to
> Ensure compliance with recent legislation particularly the Freedom of Information, Race Relations and
Disability Discrimination Acts, and Copyright legislation
> Improve internal budgeting procedures to achieve strategic goals
> Refine the financial strategy for the GSA in the light of the estates redevelopment
Strengthening strategic alliances and collaborations
In 2005 – 2006 our priority will be to
> Pursue inter-institutional collaborations in IT infrastructure support
Increasing and diversifying income streams
In 2005 – 2006 our priority will be to
> Continue to pursue commercialisation of GSA Intellectual Property including 3Motion
> Explore other routes to increase commercial income
> Concentrate fundraising on securing donations to the Creative Futures and Next Generation Scholarship
Funds and on legacy pledges
Increasing applications from home and overseas students
In 2005 – 2006 our priority will be to
> Implement targeted recruitment strategies for priority countries, subject groups and postgraduate study
> Use market intelligence to inform the development of new postgraduate courses
> Refine and implement the home recruitment strategy
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Developing the distinctive national and international profile of The Glasgow School of Art
In 2005 – 2006 our priority will be to
> Promote the significant successes of GSA students, graduates and staff and find ways to differentiate
GSA from other HEIs
Embedding an awareness of the importance of health and safety into the GSA culture for staff
and students
In 2005 – 2006 our priority will be to
> Monitor health and safety in the student curriculum
Improving corporate governance
In 2005 – 2006 our priority will be to
> Further enhance corporate governance in line with the Committee of University Chairmen’s Guide for
Members of Higher Education Governing Bodies in the UK including annual appraisal of Board members
by the Chairman
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